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Summary
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PDF Documentation  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2

Welcome to WiretapCentral
WiretapCentral is an Autodesk® rich Internet application (RIA) that provides interactive access 
to all media assets on Autodesk Wiretap® networks. It allows you to view the media content of 
your facility via a desktop-like application that runs entirely inside any web browser, such as 
those on Windows® and Mac® machines. 

WiretapCentral eliminates the need to be at an Autodesk Visual Effects and Finishing 
workstation to view thumbnails or play media. Since WiretapCentral leverages the Wiretap 
API, its actions do not interfere with workstation activity. WiretapCentral also provides a 
simple way to export content from the facility — publish at non-broadcast quality, 8-bits per 
channel, in a number of popular formats, including MPEG-4, MPEG-1, H.264, FLV (Flash® 
Video) and Raw DV. 

Set-up is simple. There is no client-side software to install — just the Adobe® Flash player 
browser plug-in. Point the browser to the WiretapCentral URL, and you are good to go. On the 
server side, WiretapCentral is delivered as a Linux® RPM package file. WiretapCentral installs 
without assistance on the Apache web server, and runs like any other web site.

WiretapCentral displays the Wiretap network as a browsable hierarchy of hosts, Stone® FS and 
standard FS framestores, projects and clips, exactly as you would find them if browsing from an 
Autodesk Visual Effects and Finishing workstation. You can view clips as thumbnails or in an 
informative and sortable “datagrid” format. In datagrid mode, project metadata includes 
resolution and frame code mode; clip metadata includes scan mode, duration, and keycode.

Play a clip, and WiretapCentral instantly accesses its full-resolution version on the framestore. 
WiretapCentral encodes it on-the-fly into the Flash video format (see “FLV” on page 6), 
streaming this live to the WiretapCentral player inside your web browser session. Load clips by 
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dragging and dropping or double-clicking. Scrub, step through frame-by-frame, pan and 
zoom, loop, and so on. Default, extended and fullscreen modes are available. A playlist keeps 
clips at hand as you browse the framestores.

Encoding clips is as simple as selecting clips in the playlist, and setting export parameters. As 
with other aspects of WiretapCentral, the bulk of the work is performed by the WiretapCentral 
server.

PDF Documentation
This documentation is available from the Help menu as a PDF (Portable Document Format) for 
online viewing or printing. 
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Overview
WiretapCentral straddles several different technologies, including Autodesk Visual Effects and 
Finishing workstations, low-bandwidth web video, and several different networking and 
collaboration protocols and tools. It is helpful to have some familiarity with these components 
before beginning to use WiretapCentral. This section provides an overview of the system 
architecture and an explanation of terms that are specific to WiretapCentral, or have a 
particular meaning in this guide.
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WiretapCentral in a Typical Setup

Autodesk Visual Effects and Finishing Workstations
WiretapCentral communicates with framestore media and metadata databases via their 
Wiretap server. The Wiretap server is installed automatically with the Visual Effects and 
Finishing software, and requires no modification for WiretapCentral. For each workstation, a 
host appears in WiretapCentral’s browser as a member of the Wiretap network.

Wiretap
Wiretap is a platform-independent application programming interface (API) that can process 
all relevant metadata transactions between a Wiretap client and Wiretap servers. (As noted 
previously, every Autodesk Visual Effects and Finishing has a Wiretap server.) Wiretap comes 
with a Client software development kit (SDK) that can be used to develop sophisticated tools. 
WiretapCentral uses the Wiretap API to make requests of the Wiretap servers. This is how 
WiretapCentral gains access to the framestores on a facility’s Wiretap network.

For more information, see the Wiretap Developer Center on the Autodesk web site:

http://usa.autodesk.com/adsk/servlet/index?siteID=123112&id=7478536
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Framestore
Framestore is the general term for online media storage. A framestore is typically a single disk 
or an array of disks. The two types of framestores exposed by Wiretap are the Stone filesystem 
(Stone FS) and standard filesystem (standard FS).

WiretapCentral Server
The WiretapCentral server is a pivotal component of the system. The WiretapCentral client 
runs in a web browser and makes requests to the WiretapCentral web server. The web server 
routes the request to the appropriate Wiretap server. 

From a networking perspective, all the high-bandwidth transactions occur between the 
Autodesk Visual Effects and Finishing hosts and the WiretapCentral server. For example, media 
is transferred from a framestore to the WiretapCentral server where it is converted to an FLV 
thumbnail and/or preview, as required by the WiretapCentral client request. This media 
transfer can be significant: as such Wiretap typically uses the GigE or Infiniband network.

WiretapCentral Client
The WiretapCentral client is a web client that runs in a standard web browser. It communicates 
solely with the WiretapCentral server. Once the WiretapCentral server has converted the high-
bandwidth media from the framestore into a light-weight FLV for the client, the only media 
transaction that occurs between the WiretapCentral server and client is a progressive download 
— thus, at any time you can play or scrub what has been downloaded, but not beyond.

The WiretapCentral server caches all FLV’s it creates. If another WiretapCentral client makes a 
request for the same clip, the server does not repeat the encoding process. It just points the 
WiretapCentral client making the new request to the existing FLV file. Cache cleanup is 
automatic.

Flash Player
WiretapCentral is a rich Internet application (RIA) compiled for the Flash run-time engine 
from source files created using the Flex application development environment. Flash excels at 
presenting interactive GUIs, parsing and rendering XML, and playing FLV video. The Flash 
player is a run-time engine distributed free by Adobe Systems.

For more information on Flex, see:

http://www.adobe.com/products/flex/

http://www.adobe.com/products/flex/
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To download the Flash player web browser plug-in, see:

http://www.adobe.com/products/flashplayer/

FLV
FLV is the Flash player video file format. It is fully supported by current versions of the Flash 
plug-in (version 9). FLV is an encoded video format (using either the Sorenson Spark Pro or 
ON2 VP6.5 codecs) that has a small memory footprint. In addition, it can carry custom 
metadata and can interact with other Flash objects.

http://www.adobe.com/products/flashplayer/
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Installation

Summary
Overview  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  7

WiretapCentral Server System Requirements  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  7

Server Installation  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  8

Client Installation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  8

Overview
WiretapCentral is delivered as a single standalone RPM package which provides the 
WiretapCentral server component. Installing the WiretapCentral server should take no more 
than a few minutes, and requires no configuration whatsoever. It relies completely on the 
existing Wiretap server framework. Wiretap servers are installed by default with Visual Effects 
and Finishing workstation software. They run automatically, and independently of the Visual 
Effects and Finishing applications.

WiretapCentral Server System Requirements
Please note the following requirements:

• 32- or 64-bit linux Red Hat® Enterprise 4 workstation.

• Direct access to the Wiretap network. The WiretapCentral server must reside on the same 
subnet/switch as the Autodesk Visual Effects and Finishing workstations.

• Apache Web Server version 2.0.52 or greater.

• Not compatible with Security-Enhanced Linux (SELinux).



Installation3

8    

Server Installation
It is recommended that you install WiretapCentral on a machine other than the Visual Effects 
and Finishing workstation. While the workstation’s CPU is protected from concurrent 
WiretapCentral server activity, competition for its resources will occur.

WiretapCentral installs to the default Apache html and cgi-bin directories:

• /var/www/html/WiretapCentral

• /var/www/cgi-bin/WiretapCentral

As noted in Chapter 2, “WiretapCentral Concepts,” on page 3, the WiretapCentral server 
converts high-bandwidth media from the framestore into light-weight FLV’s for the client. It 
caches the FLV’s in the following directory (cache cleanup is automatic):

• /var/www/html/WiretapCentral/cache 

To install the WiretapCentral server:

1. As root, type the following at the command line:

rpm -Uvh  wiretapcentral.sw.wiretapcentral-<version>.i386.rpm

Client Installation
The WiretapCentral client runs within any web browser supported by the Adobe Flash player 
plug-in, version 9 or later — for example, Mozilla® Firefox® (Linux, Windows), Safari (Mac OS 
X) and Internet Explorer (Windows). To run the client, simply open a web browser and browse 
to the system on which the WiretapCentral server is installed:

http://<hostname_or_IP>/wiretapcentral/

The Adobe Flash player, if needed, should download automatically. Next, the WiretapCentral 
Flash client loads. Once complete, the WiretapCentral UI appears in the browser. Should the 
Flash player fail to install, visit www.adobe.com/flash. 

NOTE: There is no support for 64-bit browsers at this time.
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Getting Started

Summary
Launch WiretapCentral  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  9

WiretapCentral User Interface  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  10

Launch WiretapCentral
To launch, point a web browser to the system where the WiretapCentral web server is installed. 
After a brief initialization, WiretapCentral opens, displaying the available Autodesk Visual 
Effects and Finishing workstations on the network.

To Launch WiretapCentral:

1. Open a web browser.

2. Enter the URL for WiretapCentral:

http://<host_domain>/wiretapcentral/

where <host_domain> is the name of the host on which you installed the 
WiretapCentral server. See Chapter 3, “Installation,” on page 7.

The WiretapCentral client appears in the browser. The network tree is populated by all 
detected Wiretap servers (hosts).

3. (Optional) Maximize WiretapCentral’s screen real-estate by setting the web browser to full-
screen mode:

• In Firefox or Internet Explorer on Windows, press F11.

• In Safari on Mac OSX, press Ctrl+F.

For other browser and platform combinations, consult the browser’s Help menu.

4. To end the session, close the browser. 
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The WiretapCentral client uses Flash “local shared objects” (similar to cookies) to maintain 
state information between sessions. The next time you start the client, the same projects, 
clips and playlist will appear in the UI.

WiretapCentral User Interface
The UI consists of four or five main areas, as shown in the following diagram.

Network Tree
The network tree displays the contents of the Wiretap network in a tree hierarchy. Initially, it 
lists all the hosts discovered. Expanding a host displays its framestores and the clip libraries. See 
Chapter 5, “Browsing the Wiretap Network,” on page 15.

a) Network tree b) Main view area c) Playlist

d) Clip details e) Project details

a b c

d e
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Main View Area
The main view area occupies a central portion of the UI. It presents clip thumbnails, the 
datagrid, and is home to the player. Switch between these display modes by way of the View 
menu, or double-click a thumbnail to open the player immediately. See Chapter 5, “Browsing 
the Wiretap Network,” on page 15, Chapter 7, “Listing Clips Using the Datagrid,” on page 27, 
and Chapter 9, “Using the Player,” on page 35.

a) Network tree (collapsed) b) Network tree (expanded)

a) Clip thumbnail b) Navigation breadcrumbs c) Play/Pause button

d) Scroll bars

a b

a b c

d
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Playlist
The playlist is designed to hold clips that you want to review or encode. As you browse the 
framestores on the network, you can build a list of clips of interest by dragging and dropping 
them into the playlist. See “Loading Clips into the Playlist” on page 31 and Chapter 10, 
“Encoding Clips in the Playlist,” on page 41.

Clip and Project Details
When you browse to the project level or lower, or select a specific clip, detailed information is 
presented in the project and clip details areas. See Chapter 6, “Viewing Project and Clip 
Information,” on page 23.

a) Clips in playlist b)  Playlist scroll bar

ba
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a) Project details b) Clip details

a b
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Browsing the Wiretap Network

Summary
Overview  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  15

Browsing using the Network Tree  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  16

Browsing using Thumbnails  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  18

Using Breadcrumb Navigation  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  19

Generating and Playing Thumbnail Previews . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  19

Loading Clips into the Player Directly from a Thumbnail  . . . . . . . . . . . . . . . . . . .  20

Overview
WiretapCentral presents a Wiretap network as a hierarchy of hosts, framestores, projects, 
libraries, reels and clips. When you first point a web browser to the WiretapCentral server, the 
network tree lists all hosts detected on the network — hosts being the top-level data nodes. 
Clicking on a host reveals its framestores, and so on down the hierarchy, to clips.

The network tree works in conjunction with the main view area to give you a more complete 
picture of the network and framestore contents. Initially the main view area is empty. Once you 
start navigating a host, it displays the contents of the host’s framestores, libraries, and reels, as 
you select them. By default it displays thumbnails for each clip, but it can also display clip 
metadata, in datagrid mode. See Chapter 7, “Listing Clips Using the Datagrid,” on page 27.

This section describes how to browse the Wiretap network to access media stored on Autodesk 
Visual Effects and Finishing framestores.
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NOTE: WiretapCentral’s ability to browse framestores is restricted to Autodesk Visual Effects and 

Finishing workstations running a Wiretap server (version 2008 or more recent). Some products, 

such as Autodesk Lustre ®, do not currently run a Wiretap server. Thus, their framestores are not 

accessible to WiretapCentral. In addition, clips stored on an Editing workstation’s EditDesk or an 

Effects workstation’s Desktop are not accessible. 

Browsing using the Network Tree
The network tree is an interactive tool for browsing the network and framestore hierarchy. It 
works in conjunction with the main view area to show clips as thumbnails or in datagrid mode.

a) Hosts (collapsed) b) Expanded host c) Framestore

d) Project e) Library f ) Reel

a

b

c

d
e

f
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To browse the network:

1. Click any host item in the network tree to display its framestores. While multiple 
framestores can be present, typically a host has just one framestore — stonefs, for example. 

Icons representing the framestores appear in the main view area, when in thumbnail mode.

Framestore icon 

NOTE: When you expand an item in the network tree an animated cursor indicates that a 

metadata transaction is taking place. Depending on the complexity of the tree, this can take 

some time.

2. Click a framestore in the network tree to display its projects.

Icons for the projects appear in the main view area.

Project icons 

a) Network tree with library 
selected

b) Draggable divider c) Main view area showing clip 
thumbnails

a cb



Browsing the Wiretap Network5

18    

3. Click collapsed items to further expand the network tree.

• The data structure hierarchy is exactly what you would find browsing a clip library in any 
Autodesk Visual Effects and Finishing workstation.

• Once an item is expanded, you can collapse it again by clicking its expand/collapse arrow.

• To switch between expanded items, click the item of interest. This changes the focus 
without collapsing the deselected item.

4. Note the following about browsing the Wiretap network and framestores using the network 
tree:

• Vertical and horizontal scroll bars appear when needed.

• Drag the vertical divider between the network tree and main view area to change its size.

5. To expand all an item’s children at once, choose Expand Children from the Network menu. 
See “Listing Clips Recursively Using the Datagrid” on page 28.

Browsing using Thumbnails
By default, the main view area presents the Wiretap network and framestore content as icons 
and thumbnails. For example, if a library is selected in the network tree, the main view area 
displays icons for the reels it contains. When you select a library or reel, thumbnails are 
generated for their clips. Once you have selected a host in the network tree, you can do all of 
your browsing using icons, thumbnails and breadcrumbs. 

To browse using thumbnails in the main view area:

1. Switch to thumbnail mode, if necessary, by selecting Thumbnails from the View menu.

2. Select a host in the network tree.

The main view area displays an icon for each framestore on the host.

3. Double-click the icon for the framestore of interest.

The main view area displays the projects contained by the selected framestore.

4. Continue browsing the contents of the current host:

• Double-click any data-structure icon to open it.

• Double-clicking a clip thumbnail switches the main view area to player mode and loads the 
clip into the player. See “Generating and Playing Thumbnail Previews” on page 19 and 
“Loading Clips into the Player Directly from a Thumbnail” on page 20.

• To switch hosts, select the new host in the network tree.
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Using Breadcrumb Navigation
WiretapCentral uses breadcrumbs to show your position within the framestore file system 
hierarchy. These appear along the top of the main view area as you browse. In addition, each 
breadcrumb is a hot-spot. Click one, and you jump immediately to its location.

To use breadcrumbs in the Clips tab:

1. Switch to thumbnail mode, if necessary, by selecting Thumbnails from the View menu.

2. Browse the network and framestores using the network tree or main view area.

Notice the breadcrumbs that appear as you browse.

a) Breadcrumbs 

3. Click any breadcrumb to return to that level of the network hierarchy.

Generating and Playing Thumbnail Previews
Icons and thumbnails in the main view area provide an intuitive means to navigate the network 
and framestores. More importantly, however, the thumbnails provide you with:

• Metadata corresponding to each clip, including the clip’s name, timecode, duration, tracks, 
and origin (Stone or soft-import).

• A playable, scrubbable representation of the clip. 

• A gateway to loading the clip directly into the player (see “Loading Clips into the Player 
Directly from a Thumbnail” on page 20).

To generate and play thumbnail previews in the main view area: 

1. Navigate to the clip of interest.

By default, a single-image thumbnail is automatically generated for each clip in the main 
view area.

a
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2. Click on the progress bar to generate the playable thumbnail.

Thumbnail generation is normally faster than real-time, depending on the network 
interface and processing power of the WiretapCentral server. Thumbnails are partially 
playable and scrubbable even when processing or downloading is not yet complete.

The meaning of the different colours is explained below.

3. Play the thumbnail by clicking the Play icon.

4. Scrub the thumbnail by dragging over the progress bar.

Loading Clips into the Player Directly from a Thumbnail
A typical workflow involves setting up several clips for playback by dropping them into the 
playlist then selectively loading them into the player (see Chapter 8, “Loading Clips into the 
Playlist,” on page 31). However, you can also load clips into the player directly from the main 
view area, in thumbnail mode.

a) Current timecode b) End timecode c) Video track indicator

d) Scrubbable progress bar e) Clip name f ) Play/Pause icon

orange 
corkscrew

Thumbnail is not yet encoded.

grey A grey progress bar indicates thumbnail is being generated. Grey from 
start-to-finish indicates thumbnail is generated and resides in your 
browser’s cache.

blue Playable thumbnail has been generated on the server, but remains to be 
downloaded into your cache.

yellow Indicates position when playing or scrubbing.

a b c

d

e f
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To load clips into the player directly from a thumbnail:

1. Navigate to the clip of interest and double-click its thumbnail.

The player appears in the main view area loaded with the clip. 

As with thumbnails, clips in the player are playable while processing or downloading is 
taking place.

2. To switch back to thumbnail mode:

• Select Thumbnails from the View menu.

• Press ~ (tilde). This hot key always switches between the player and the datagrid or 
thumbnail mode.

For more information on playing clips in the player, see Chapter 9, “Using the Player,” on 
page 35.



Browsing the Wiretap Network5

22    



   23

Viewing Project and Clip Information

Summary
Viewing Project Information . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  23

Viewing Clip Information . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  24

Viewing Project Information
When you browse to the project level in the network tree or main view area (in thumbnail 
mode), the current project’s settings are displayed in the project details area. This information 
persists until you select a node from another project.

Project Details area

The following table explains the contents of the project details area.

Attribute Description Example

Name The name given to the project when it was created. My Little Pony

Description A more meaningful description. Often, the default 
value of the creation date appears here.

15-second TV spot 
(Superbowl).

Creation Date Creation date in the form YYYY-MM-DD HH:MM:SS. 2007-07-11 17:46:01

Resolution Default resolution and bit- depth. 1920x1080@10-bit

Aspect Ratio Default aspect ratio. 1.77778

Scan Mode The scan mode applied to the project’s newly 
processed clips.

Field 1, Field 2, 
Progressive.
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Viewing Clip Information
Clip information is automatically displayed in the clip details area when you select or play a clip. 
It persists until you select another clip. For clarity, the selected clip is shown along side the data.

Clip Details area

The following table explains the contents of the project details area.

Proxy Width Default width in pixels, for fixed-width proxies. 720

Proxy Scale Proxy size as a percentage of full-res image. 0.5

Proxy Bit Depth Colour channel bit-depth for proxies. 8-bit, Full Res

Proxy Quality Quality of proxies for viewing purposes. Draft, Coarse, 
Medium, Quality, 
Bicubic.

Proxy Width > Clips greater than this width will trigger proxy 
generation. For conditional proxies only.

720

Proxy > 8-bit The project generates proxies only for 10-bit, 12-bit 
or 12-bit unpacked clips. For conditional proxies 
only.

off

Attribute Description Example

Clip Name The name given to the clip when it was created. NTSC_default

Clip Creation 
Date

Creation date and time in the form Day Mon DD 
HH:MM:SS YYYY.

Tue Sep 4 12:08:42 
2007

Source 
Timecode

The timecode and frame numbers on source clip that 
was loaded from VTR.

00:00:44+22

Tape Name Name (or number) of the associated tape. Archive 2007

Resolution Resolution and bit-depth. 1920x1080 10-bit

Frame Rate Clip’s frame rate (24, 25, 30, 50, 60 fps) 24.000000

Scan Mode The clip’s field dominance. Field 1, Field 2, 
Progressive

Attribute Description Example
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Duration Duration in time and frames. 00:00:00+23

Video Frames Number of frames per second. 24

Audio Tracks Number of audio tracks. 0

Aspect Ratio Aspect ratio. 1.000000

Format Video format (NTSC, PAL, HD, RGB). rgb

Node ID Persistent ID that identifies each node on the host. /stonefs/HD_v2008/
STONE_HD

Attribute Description Example
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Listing Clips Using the Datagrid

Summary
Overview  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  27

Listing Clips Using the Datagrid  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  28

Listing Clips Recursively Using the Datagrid  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  28

Overview
By default, the main view area displays the contents of the current library or reel as clip 
thumbnails. The datagrid presents an alternative view, presenting clips in table format, with 
sortable, repositionable columns.

The datagrid allows you to locate or compare clips based on clip metadata — name, tape name, 
duration, etc. When used in conjunction with the Network menu Expand Children command, 
you can list all the clips in all ‘subdirectories’ of any network object — host, framestore, project, 
library or reel — in one click.

a) Network tree b) Datagrid

a b
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Listing Clips Using the Datagrid
The datagrid presents clip metadata in a sortable table with repositionable columns.

To list clips using the datagrid:

1. In the network tree, navigate to the library or reel of interest.

2. Switch to datagrid view by selecting Datagrid from the View menu.

The list of clips contained in the library or reel appears in the datagrid.

3. Notice the following:

• In datagrid view, only clips are listed (not projects, libraries, reels, etc.).

• The datagrid contains one row for each clip in the current library or reel. 

• Rearrange columns by dragging them to their new position — column order persists for 
the duration of the current WiretapCentral client session only.

• Sort the list by clicking a column header.

4. Select a row to view its thumbnail in the Clip Details area.

Select multiple rows by pressing the CTRL or SHIFT key and clicking.

5. To switch back to thumbnail mode:

• Select Thumbnails from the View menu.

• Press ~ (tilde). This hot key always switches between the player and the datagrid or 
thumbnail mode.

For more information on playing clips in the player, see Chapter 9, “Using the Player,” on 
page 35.

Listing Clips Recursively Using the Datagrid
By default, the datagrid lists the clips for the currently selected library or reel only. However, you 
can expand the children of any network item — a host, framestore, project, library or reel — all 
at once, using the Network menu Expand Children command. In datagrid mode, this populates 
the datagrid with information on all clips found in the sub-hierarchy. Expanding the children 
for a project provides a complete inventory of the project’s media assets, for example.

To list clips recursively using the datagrid:

1. In the network tree, navigate to the host, framestore, project, library or reel of interest.

2. Switch to datagrid view by selecting Datagrid from the View menu.
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3. In the Network menu, select Expand Children.

A confirmation dialog appears, cautioning that the operation can take some time.

4. Click OK in the dialog. 

• In the Network tree, a spinning cursor indicates the recursive scan is in process. All sub-
items are expanded.

• As the scan proceeds, the datagrid is populated by the incoming stream of metadata.

• Once complete, the results persist until you select something else in the Network tree. 
However, the data is cached locally for the duration of the session. The second time you 
expand the children in the same place the results are loaded immediately. 
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Loading Clips into the Playlist

Summary
This section describes how to work with the playlist.

Overview  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  31

Loading Clips into the Playlist  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  32

Displaying Clips as a List  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  33

Removing Clips from the Playlist . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  33

Overview
The playlist is a holding area for clips you want to play back or encode. It can concurrently 
contain clips that you load from different hosts, projects, reels and clip libraries at the same 
time. Like other elements of the UI, the playlist persists between sessions.

When the playlist contains numerous clips, it can be convenient to view them as a list rather 
than thumbnails. When clips are no longer needed, you can remove them from the playlist. 
Clips must be in the playlist before they can be encoded. See Chapter 10, “Encoding Clips in the 
Playlist,” on page 41.
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Loading Clips into the Playlist
Load clips into the playlist by dragging and dropping from the main view area, in thumbnail or 
datagrid mode.

To load clips into the playlist:

1. In thumbnail or datagrid mode, navigate to a library or reel containing clips.

2. Load a clip into the playlist by dragging the thumbnail or data row to the playlist.

A semi-transparent thumbnail or data row indicates you have acquired the clip. A green 
plus-sign (+) indicates you are over the playlist. 

3. It is also possible to load several clips at once into the playlist:

• Ctrl-click multiple clips to select them, then drag the selections to the playlist. 

• Shift-click a range of clips, then drag the selections to the playlist.

4. Double-click a clip in the playlist to load it into the player.

a) Clips in playlist b)  Playlist scroll bar c) List view

ba c
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Displaying Clips as a List
By default, clips in the playlist tab are displayed as thumbnails, but you can also display them as 
a list. This is not the same as listing clips in the datagrid — in the playlist, clips are listed by name 
only, to save space.

• From the Playlist menu, select View then List View.

Removing Clips from the Playlist 
When clips are no longer needed, they can be removed from the Playlist. This is a non-
destructive action — it has no effect on the underlying clips on the framestores.

• From the Playlist menu, select Clear All.

• Select one or more clips in the playlist and then press the DELETE key.
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Using the Player

Summary
Overview  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  35

Loading a Clip into the Player  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  36

Playing Clips . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  37

Panning and Zooming the Clip  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  37

Changing the Player Layout . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  38

Overview
Thumbnails are convenient for previewing clips, but the player is larger and offers considerably 
more playback options. It presents clips at a width of 720 pixels, and usually at 100% JPEG 
quality. In addition, the player has controls for stepping through the action, looping, etc. 

Player

From most areas of the UI, double-clicking a clip opens the player loads the clip into it. 
WiretapCentral automatically generates and downloads the high-resolution version from the 
clip on the framestore, then streams the playable version to the player. For long clips, this can 
take a few seconds, depending on the network interface and processing power of the 
WiretapCentral server. If the clip has an NTSC or PAL proxy on the framestore, the process is 

double-click
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usually very close to real-time. As with thumbnails, you can begin playing as soon as the clip 
begins downloading.

Loading a Clip into the Player

To load a clip into the player:

1. Navigate to the clip of interest.

2. Double-click on the clip to open the player and load the clip. You can double-click a 
thumbnail, a row in the datagrid, or a clip name in the playlist.

The player appears in the main view area with the clip loaded.

The meaning of the different colours in the time bar is explained below.

orange 
corkscrew

Clip is not yet playable.

grey A grey progress bar indicates a playable clip is being generated. Grey 
from start-to-finish indicates the clip is generated and resides in your 
browser’s cache.

blue Playable clip has been generated on the server, but remains to be 
downloaded into your cache.
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Playing Clips
The player’s controls are shown in the following diagrams.

The playback controls are detailed below.

Panning and Zooming the Clip
You can pan the clip across the canvas and zoom in and out, even while the clip is playing.

To pan and zoom a clip:

1. To pan the clip, drag it using the cursor.

2. To zoom in and out:

• Click the [+] and [-] UI buttons.

a) Loop/mute/smooth display b) Playback controls c) Time bar

d) Zoom controls

a) Pause b) Play c) Fast-forward

d) Single frame forward e) Jump to end

a b c d

a b c d e
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• Use the wheel on the mouse.

3. To reset the player’s default pan and zoom settings, click Home.

4. To fit the clip to the available player canvas, click Fit.

Changing the Player Layout
Use the F key to cycle between WiretapCentral’s layout options for the player, or make a 
selection from the Layout menu.

Default
The default mode displays as much of the clip as possible in the given screen real-estate. On 
higher-resolution monitors this ought to be enough to show the whole frame.

Default mode

Extended
Extended mode removes the tree and playlist, giving more space for the player.

Extended mode
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Fullscreen
Fullscreen mode removes everything from WiretapCentral except the player.

Fullscreen mode
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Encoding Clips in the Playlist

Summary
Overview  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  41

Encoding Clips . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  41

Overview
Once you select the clips in the playlist, you are a few short steps away from having stand-alone 
playable clips. You can export clips in the following formats: MPEG-4, MPEG-1, H.264, FLV 
(Flash Video) or Raw DV. WiretapCentral guarantees frame and timecode accuracy; however, 
it is important to note the following limitations:

• Video clips are not broadcast-quality.

• Clips are down-converted to 8-bits per channel RGB.

• Film clips lack colour management.

With these limitations in mind, it is recommended that any client final approval be done using 
the final delivery medium.

WiretapCentral exports encoded clips to the following directory on the WiretapCentral server:

/var/www/html/WiretapCentral/export

This is seen by a web browser as:

http://<hostname_or_IP>/wiretapcentral/export

Encoding Clips
Encoding clips is a three step process: you name the export session, choose the encoding format 
and parameters, and export the file. Once the clip is encoded, you have the option of adding it 
to a TAR file. All steps are done within the Export wizard.
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WiretapCentral encodes clips on the server, and they remain there once complete. While the 
WiretapCentral client running in your browser provides a mechanism for downloading 
encoded clips, it is up to your web administrator to maintain or delete them on the server.

NOTE: Only fully-rendered clips can be encoded.

To encode a clip:

1. Navigate to the clip of interest and drag it into the playlist.

2. Select Export from the Playlist menu.

The export wizard appears, prompting you to name the export session. This name is used to 
create a subdirectory on the server to hold the encoded clips.

Step 1: Name the export session

3. Name the export session — the clip name is used by default — and press the ENTER key or 
click Step 2.

The export wizard presents the encoding options.

Step 2: Choose encoding options

4. Choose encoding options, as desired, and click Step 3.
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The wizard presents the final step prior to encoding.

Step 3: Begin encoding

5. Click Export to set the process in motion. You can also go back to a previous step to review 
your choices by clicking on the step.

6. Upon successful completion the wizard provides you with two options: to view the 
generated content on the WiretapCentral server, or to add the clip (or clips) to a TAR file.

Supplemental step

7. Click View Content to open a new browser (or browser tab) on the server directory 
containing the generated clip. Click Package to add the clip to a TAR file.

The directory created on the server is based on the export session name.

8. To view the generated clips once the export session is complete, select Export and then View 
Packages from the Playlist menu.

This opens a browser or tab on the WiretapCentral export base directory.
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